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1 Introduction 
Use your .Net code in ArcMap just as easy as you were used to work with VBA scripts. With 
the ARIS .Net Scripting Tool you can create, edit and run .Net code within an ArcMap 
session. A perfect solution to test parts of your code during application development or to 
switch from VBA to VB.Net. 
 
VBA macro support is deprecated in ArcGIS 10 and will not be supported in releases after 
ArcGIS 10.2. Migration was only possible to Visual Studio or to Python, but now you can stick 
to scripting inside ArcGIS with the .Net Scripting Tool. 
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2 System requirements 
To use the ARIS .Net Scripting Tool the following software must be installed on your 
computer: 

• Windows XP, Vista or Windows 7.  
• Microsoft .NET Framework 3.5 SP1. 
• ESRI ArcGIS 10.0, ArcGIS 10.1, or ArcGIS 10.2 / 10.2.1 
• ArcObjects SDK for the Microsoft .Net Framework* 

 
Required is one of the following ArcGIS 10.0 / ArcGIS 10.1 / ArcGIS 10.2 / ArcGIS 10.2.1 
licenses: 

• ArcView / ArcGIS for Desktop Basic 
• ArcEditor / ArcGIS for Desktop Advanced 
• ArcInfo / ArcGIS for Desktop Enterprise 

 
See http://www.aris.nl/download for availability of ARIS .Net Scripting Tool versions.  
 
* See Installing ArcObjects SDK without Visual Studio in Chapter 3. 

http://www.aris.nl/download
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3 Installation 

3.1 Installing .Net Scripting Tool for ArcMap 
Before installing ARIS .Net Scripting Tool for ArcMap please check the system requirements. 
 
Installation of the ARIS .Net Scripting Tool for ArcMap is accomplished by the following steps: 
 
1. Execute ARISDotNetScriptingToolSetup.msi. The Windows installer will guide you 

through the installation process. 
 
2. In ArcMap, from the Customize menu choose Extensions and make sure there is a 

checkmark next to ARIS .Net Scripting Tool. Now, in the Customize menu the menu 
option .Net Scripting should be present. 

 
If the .Net Scripting option is not present, do the following: 
1. From the Customize menu choose Customize mode…. 
2. Select the Commands tab. 
3. From Categories select ARIS .Net Scripting Tool. 
4. Drag and drop .Net Scripting command to the Customize menu. 
 

3.2 Installing ArcObjects SDK without Visual Studio 
The .Net Scripting Tool requires the ArcObjects SDK for the Microsoft .Net Framework to be 
installed. ArcObjects SDK is an optional part of the ArcGIS Desktop setup.  
 
The ArcObjects SDK setup requires Visual Studio to be installed because prior to the 
existence of the .Net Scripting Tool the installation of ArcObjects SDK for .Net was only 
usefull if Visual Studio was installed. 
 
When ArcObjects SDK setup stops because Visual Studio is required during setup you can 
choose to install Visual Studio (e.g. Visual Studio Express) or do a minor change in the 
registry to let the ArcObjects SDK succeed. ArcObjects SDK and the .Net Scripting Tool do 
not need anything from Visual Studio. 
 
Here is a work around to install the ArcObjects SDK without Visual Studio being installed. 
 
Before installing the ArcObjects SDK for the Microsoft .Net Framework 
Add the following registry key: 
 
On a 32-bits operating system: 

[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\VisualStudio\10.0] 
 
On a 64-bits operating system: 

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\VisualStudio\10.0] 
 

 
Add two new string values to the key: 

Value Name: InstallDir 
Value Data: C:\\FakeVisualStudio 
 
Value Name: ShellFolder 
Value Data: C:\\FakeVisualStudio 
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Installing the ArcObjects SDK for the Microsoft .Net Framework 
1. Start the ArcGIS setup. 
2. In the startup-screen select the Setup for ArcObjects SDK for the Microsoft .Net 

Framework. 
3. Select none of the features for Visual Studio and VCPP to be installed. These features 

are of no use if you do not have Visual Studio installed. 
 
After installing the ArcObjects SDK for the Microsoft .Net Framework 
Remove the registry key you added. 
 
Note: If you choose to install Visual Studio after installation of ArcObjects SDK a reinstall of 
ArcObjects may be necessary. 
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4 Registration 
 

4.1 Trial license 
The distributed version of the ARIS .Net Scripting Tool for ArcMap is a full functional version 
with a trial license. This means it can be used for evaluation purposes for 5 days. In this 
period scripts can only be executed once per ArcMap session. After this period, the ARIS .Net 
Scripting Tool will be locked until a valid licence key is entered. 
 
While in trial mode, each time an object is retrieved for processing a reminder message will 
be shown. 
 

 
 
Pressing the Register button will present you with the following dialog, where you must enter 
your name and the registration key (If you want to use .Net Scripting Tool in trial mode, wait 
till the OK button comes available and press OK). 
 

 
 

4.2 Register 
If you do not yet have a registration key press the Buy Now! button. This will take you to our 
online store, where you can order this product. Note that you will need the hardware 
fingerprint of the computer where you want to install the tool, shown in the dialog above. After 
you complete your purchase, a personal registration key will be sent to you by email. Please 
store this key in a safe place. 
 
Once you have entered a valid registration key, press OK. This key will be stored on your pc. 
The reminder message will not be shown again. 
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To register the .Net Scripting Tool it is also possible to run ARISDotNetScriptingToolA.exe. 
This executable will show the reminder message to register the tool. 
 
Note that after registering the tool from within ArcGIS, ArcGIS should be restarted for the 
permament license to be activated. 
 
If you have the ARIS License Checker installed, the registration forms are also accessible 
through the ARIS License Checker. The ARIS License Checker is available without cost from 
http://www.aris.nl/download. 

4.3 Unregister 
When your license is not valid anymore through changes on your PC or if you want to move 
your license to a new PC, you can obtain a new license (fair use policy) after you unregister 
the license using the ARIS License Checker. The ARIS License Checker is available without 
cost from http://www.aris.nl/download. 
 
Send an e-mail to helpdesk@aris.nl with: 
• ARIS product name and version 
• Original hardware fingerprint (active license, if available) 
• Registration name (active license) 
• License key (active license) 
• Confirmation code (from unregister) 
• New hardware fingerprint (from register) 
 
If you are entitled to receive a new license key, a new key will be sent to you by e-mail as 
soon as possible (same day, but might also take some days as this is not an automated 
process). 

4.4 Invalid license 
When major changes to your hardware have caused the license to become invalid, you can 
obtain a new valid license if you provide the necessary information (fair use policy). Note that 
it is no longer possible to get license information using the license checker, use the 
information in the email you received with your license. 
 
To verify that hardware changes are the cause of the invalid license, you need to send a 
‘Hardware Change Log’ file with the request for a new license. 
 
To get this Hardware Change Log, start ARIS License Checker, select the ARIS product and 
press the AHCL button, you will be asked for a location to store the file.  
 
Send an e-mail to  helpdesk@aris.nl with: 
• ARIS product name 
• Original hardware fingerprint (from license information sent by email) 
• Registration name (from license information sent by email) 
• License key (from license information sent by email) 
• AHCL file (from AHCL) 
• New hardware fingerprint (from Register/Enter Key) 
 

http://www.aris.nl/download
http://www.aris.nl/download
mailto:helpdesk@aris.nl
mailto:helpdesk@aris.nl
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5 Version History 

5.1 Version 1.0 
Version 1.0 is the first release of the ARIS .Net Scripting Tool for ArcMap and can be used 
with ArcGIS 10.0, ArcGIS 10.1 and ArcGIS 10.2. 

5.2 Version 1.0.1 
ArcGIS compatibility  
•  Version 1.0.1 of the ARIS .Net Scripting Tool for ArcMap can be used with ArcGIS 10.2.1 
(and still ArcGIS 10.0, 10.1 and 10.2).
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6 Using .Net Scripting Tool in ArcMap 

6.1 Getting started 
The following walk-through shows how to get started with the .Net Scripting Tool. 
 
In the Customize menu of ArcMap choose Extensions. In the extensions dialog box check 
ARIS .Net Scripting Tool for ArcMap to enable the extension. 
 

 
 
Now choose .Net Scripting in the Customize menu.  
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The .Net Scripting window is opened. By default a module script named Module1 is created 
for you. 
 

 
 
The module script contains a public sub called Main. Add the following line of code to sub 
Main as shown below. 
 
 Public Sub Main() 
  MsgBox(Application.Document.Title) 
 End Sub 
 
Save the ArcMap document with the name GettingStarted.mxd. 
 
In the menu select Code | Build to build the code. 
 

 
 
 
After building the code, "Module1.Main" will appear in the dropdown list and the Run button 
will be enabled. 
 
 



ARIS .Net Scripting Tool for ArcMap - User's Manual 

ARIS 12   

 
 
 
Finally click Run to run the sub Module1.Main and the name of the current ArcMap document 
will be shown. 
 

6.2 Edit 
In the .Net Scripting window you can edit your scripts in a tabbed editor. In the editor all 
common text editor functions are available. 

6.3 Build 
Building the code will check the code for errors. Note that code in all scripts will be checked. If 
the code was build successfully, all public subs without arguments will be listed in the 
dropdown list in the Editor toolbar.  
If building failes a list of errors will be shown in the Messages tab at the bottom of the .Net 
Scripting window. 

6.4 Run 
After building the code all valid subs will be listed in the dropdown list. Only public subs 
without arguments will show in the list. Select the sub you want to run and click Run. 

6.5 Save 
Your scripts will be saved in the current ArcMap-document when you click the Save option in 
the File menu of the .Net Scripting Window or the Save button in ArcMap. 

6.6 References 
By default 5 libraries are referenced. These references are required and can not be removed. 
They are: 
− System 
− MicroSoft.VisualBasic 
− ESRI.ArcGIS.ArcmapUI 
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− ESRI.ArcGIS.Framework 
− ESRI.ArcGIS.System 
 
You can add your own references in three ways: 
− Click References in the Tools menu. The References window will be opened. Click Add to 

add a reference. 
− Click Add Reference in the Tools menu. 
− At the top of the module add '#Reference <Reference Name>.dll. Defining references this 

way is a shortcut for the methods mentioned above. 
Example: 

 '#Reference ESRI.ArcGIS.Carto.dll 
 

6.7 Connect to ArcMap 
To access ArcMap from your code there are two variables available. These are: 
 
 Application  of type ESRI.ArcGIS.Framework.IApplication 
 ThisDocument  of type ESRI.ArcGIS.ArcMapUI.IMxDocument 
 
See the regular ESRI ArcObjects references for more detailed information about these 
interfaces. 

6.8 Options 
Click Options in the Tools menu to open the Options window. In the Options window the 
General and Compile options can be modified. 

6.8.1 General options 
In the Editor section the font size and tab size of the code editor can be set. The default font 
size is 10. The default tab size is 2. 
 
In the Messages section the font size of the messages shown in the Messages, Debug and 
Output tabs can be set. The default font size is 10. 

6.8.2 Compile options 
In the Options section the settings for Option Explicit and Option Strict can be set. These 
settings apply to the code of all scripts. Settings specified for these compile options in the 
code of individual scripts are overruled. 
 
The Treat warning as error option can be checked to treat warnings as errors. If this option is 
checked, building the code will fail if warnings occur. If this option is not checked, warnings 
will be listed but building the code will succeed. 
 

6.9 Windows 

6.9.1 Scripts Explorer 
In the .Net Scripting window you can add your own scripts. The scripts can be managed in the 
Scripts Explorer. To open the Scripts Explorer click the button at the left side of the .Net 
Scripting window. The context menu in the Scripts Explorer contains the following options: 
 
• View Code 
• Insert 
• Import File… 
• Export File… 
• Delete 
• Rename 
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6.9.1.1 View Code 
Clicking this option will open the script in a new tab or will select the tab associated with the 
script if it was already open. 

6.9.1.2 Insert script 
The Insert option contains 4 sub options. You can insert a Module script, Class script, 
Interface script or Enum script. Depending on the type you choose, the script will contain a 
module, class, interface or enum declaration. The script is added to the Scripts tree with a 
default name which can be changed.  

6.9.1.3 Import file 
Another way to create a script is to import a Visual Basic file (.vb). Click the Import File option, 
browse to your vb-file and select your file. The name of the script will be the same as the 
filename without extension. If there is already a script with the same name, a number is 
added at the end of the name. 

6.9.1.4 Export File… 
Exporting a script will create a Visual Basic file containing the script. 

6.9.1.5 Delete script 
A script can be deleted with the Delete option. Before the script is definitely removed from the 
project, you can choose to export the script to a file. 

6.9.1.6 Rename script 
The name of a script can be renamed with the Rename option. All scripts should have a 
unique name. If you rename a script to a name the already exists, you will get a warning and 
will have to choose another name. 
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6.9.2 Messages window 
In the Messages window build errors, warnings and runtime errors are listed. Double clicking 
on the error will jump to the line in the code in which the error occurred. 
 

6.9.3 Debug window 
The Debug window can display messages that are generated in the code by the command 
Debug.Print which is defined in the System.Diagnostics library. 
 

6.9.4 Output window 
The Output window can display messages that are generated in the code by the command 
Console.Write or Console.Writeline which are defined in the System library. 
 

6.10 Example  
The example below shows how to add a MapFrame in an ArcMap document. The example 
can be found in <installation>\Example\World.mxd. 
 
In the example a second MapFrame is added to the PageLayout. Try the example and see 
what happens. 
 

 
 
 
1. Open <installation>\Example\World.mxd in ArcMap. 
2. Open the .Net Scripting Window. 
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3. Build the scripts. 
4. Select sub AddMapFrame.Main from the dropdown list. 
5. Run the selected sub and see the result in the PageLayout. 
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7 Known issues  
If ARIS .Net Scripting Tool for ArcMap is not available in Customize / Extensions after 
installation, deinstall the tool and try to install it again and explicitly run the setup as 
administrator. Note: Having administrator-privileges may not be sufficient.  
 
After registering the .Net Scripting Tool for a permanent license it could occur that you have to 
enter your registration name and code every time you start up ArcGIS. Be sure to register the 
tool as an administrator. Note: Having administrator-privileges may not be sufficient. 
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Appendix A. License Agreement 
 
ARIS Software License Agreement for ARIS .Net Scripting Tool for ArcMap 
---------------------------------------------------------------- 
This is a license agreement and not an agreement for sale. This license agreement 
(hereinafter referred to as AGREEMENT) is between the end user (hereinafter referred 
to as LICENSEE) and ARIS b.v., The Netherlands (hereinafter referred to as ARIS), and 
gives the LICENSEE certain limited rights to use the proprietary ARIS software, 
examples, on-line and hardcopy documentation and updates (if applicable), hereinafter 
referred to as PRODUCT. All rights not specifically granted in this AGREEMENT are 
reserved to ARIS. 
 
Ownership and grant of license 
------------------------------------------------- 
ARIS and its third party licensor(s) retain exclusive rights, title, and ownership of 
the copy of the PRODUCT licensed under this AGREEMENT and hereby grant to LICENSEE a 
personal, non-exclusive, non-transferable license to use the PRODUCT based on the 
terms and conditions of this AGREEMENT. From the date of receipt, the LICENSEE shall 
agree to make reasonable efforts to protect the PRODUCT from unauthorized use, 
reproduction, distribution, or publication. 
 
Copyright 
--------------- 
The PRODUCT is owned by ARIS and partly by its third party licensor(s) and is 
protected by Dutch copyright laws and subject to international laws, treaties, and/or 
conventions. 
The LICENSEE agrees not to export the PRODUCT into a country that does not have 
copyright laws that will protect ARIS's proprietary rights. 
 
Permitted uses 
----------------------- 
The LICENSEE may use the number of copies of the PRODUCT for which license fees have 
been paid on computer system(s) and/or specific computer network(s) for the LICENSEE's 
own internal use. 
 
The LICENSEE may install the number of copies of the PRODUCT for which license or 
update fees have been paid onto permanent storage device(s) on computer system(s) 
and/or specific computer network(s). 
 
The LICENSEE may make one (1) copy of the PRODUCT for archival purposes only, during 
the term of this AGREEMENT, unless the right to make additional copies has been 
granted by ARIS to the LICENSEE in writing. 
 
The LICENSEE may use parts of the documentation in other documents for LICENSEE's own 
internal use only with the purpose of using or encouraging to use the PRODUCT. 
 
Uses not permitted 
------------------------------ 
The LICENSEE shall not sell, rent, lease, assign, timeshare, or transfer, in whole or 
in part, or provide unlicensed third parties access to prior or present versions of 
the PRODUCT, any updates, or the LICENSEE's rights under this AGREEMENT. 
 
The LICENSEE shall not reverse, engineer, decompile, or disassemble the PRODUCT, or 
make any attempt to alter the license number and other license information shown in 
the about box. 
 
The LICENSEE shall not remove or obscure any ARIS copyright or trademark notices. 
 
The LICENSEE shall not make additional copies of the PRODUCT beyond what is laid down 
in the "permitted uses" section of this AGREEMENT. 
 
Term 
-------- 
The license granted by this AGREEMENT shall commence upon LICENSEE's receipt of the 
PRODUCT and shall continue until such time as:· the LICENSEE elects to discontinue the 
use of the PRODUCT; 
· ARIS terminates the agreement due to the LICENSEE's material breach of this 
  AGREEMENT. 
Upon termination of this AGREEMENT in either instance, LICENSEE shall return to ARIS 
the PRODUCT and any whole or partial copies in any form. The parties hereby agree that 
all provisions operating to protect the rights of ARIS shall remain in force, should 
breach occur. 
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Limited Warranty 
-------------------------- 
ARIS warrants that the media upon which the PRODUCT is provided will be free from 
defects in materials and workmanship under normal use and service for a period of 
ninety (90) days from the date of receipt. 
 
Except for the above express limited warranties, the PRODUCT is provided "as is", 
without warranty of any kind, either express or implied, including, but not limited 
to, the implied warranty of merchantability and fitness for a particular purpose. 
 
Exclusive Remedy and Limitation of Liability 
-------------------------------------------------------------------- 
During the warranty period, ARIS's entire liability and the LICENSEE's exclusive 
remedy shall be the return of the license fee paid for the PRODUCT that does not meet 
ARIS's limited warranty and that is returned to ARIS or its dealers with a copy of the 
LICENSEE's proof of payment. 
 
ARIS shall not be liable for indirect, special, incidental, or consequential damages 
related to LICENSEE's use of the PRODUCT, even if ARIS is advised of the possibility 
of such damage. 
 
Waivers 
------------- 
No failure or delay by ARIS in enforcing any right or remedy under this AGREEMENT 
shall be construed as a waiver of any future or other exercise of such right or remedy 
by ARIS. 
 
Order of Precedence 
--------------------------------- 
 
Any conflict and/or inconsistency between the terms of this AGREEMENT and any purchase 
order, or other terms shall be resolved in favour of the terms expressed in this 
AGREEMENT, subject to Dutch law, unless agreed otherwise. 
 
Governing Law 
------------------------ 
This AGREEMENT is governed by the laws of the Netherlands without references to 
conflict of laws principles. 
 
Entire Agreement 
--------------------------- 
The parties agree that this constitutes the sole and entire agreement of the parties 
as to the matter set forth herein and supersedes any previous agreements, 
understandings, and arrangements between the parties relating hereto and is effective, 
valid, and binding upon the parties. 
 
ARIS is a registered trademark, the Netherlands. 
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